New features, 2017-3 run

General
- Safety requirements will be enforced more diligently. Please make sure you are wearing proper apparel when present at the beamlines, and are using proper Personal Protection Equipment (PPE) when conducting experiments.

Beamlines
There are new focusing mirrors on ID-D. The flux has improved across all size beams albeit not to the values before the mirror problems.

<table>
<thead>
<tr>
<th>Beam Size</th>
<th>Current</th>
<th>Before Feb 2017</th>
<th>Last two runs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full beam</td>
<td>2.74E+12</td>
<td>9.65E+12</td>
<td>8.69E+11</td>
</tr>
<tr>
<td>20 µm</td>
<td>1.91E+11</td>
<td>1.19E+12</td>
<td>5.67E+10</td>
</tr>
<tr>
<td>10 µm</td>
<td>8.34E+10</td>
<td>3.81E+11</td>
<td>1.98E+10</td>
</tr>
<tr>
<td>5 µm</td>
<td>5.96E+10</td>
<td>1.91E+11</td>
<td>1.29E+10</td>
</tr>
</tbody>
</table>

Due to the new mirrors, current operational energy range is restricted to 9.36 – 18.4 keV range

Remote connection
- The NX webplayer is now available for users for remote connection: [https://www.gmca.aps.anl.gov/remote/#webplayer](https://www.gmca.aps.anl.gov/remote/#webplayer). The video tutorial is available in the same link. It is a convenient option not requiring anything to be installed on user computers.

Screening tab/Sample Automounter
- There is a new sample automounter installed in 23ID-D beamline, with the dewar capacity of 18 pucks (288 samples).
- There is a new template for sample spreadsheet, made up for 18 pucks. Users should download this template for editing if they intend to use their own spreadsheet.
- More than one user group can share the dewar. In those cases, the host will communicate with the users which positions in the dewar they can use. Users should update the spreadsheet accordingly – i.e. edit only the positions assigned to them. The assigned positions will be accessible only to the given user.
- 23ID-B still has the 6-puck automounter. However, the position assignment will work on this beamline as well. Therefore, if the dewar is being shared by multiple users, use only the assigned positions.

Collect tab
- We continue efforts to fully integrate EIGER 16M into our beamline and control systems. Currently, the only feature still not fully implemented, is vector data collection with discrete sites (i.e. non-helical). Vector data collection in helical mode works fine.

Data analysis
- Autoproc is now available for academic users only.
New features, 2017-2 run

General
- On 23ID-D, our vertically focusing mirror has incurred a major problem in Feb. 2017. As a result, the flux for all beam sizes was reduced by a factor of 10 to 20. Therefore, you may need to use a combination of decreased attenuation and increased exposure time.
- The mirror problem has also restricted the current energy range on 23ID-D to 6 – 15 keV.

Data collection
- For Eiger 16M detector on 23ID-B: The diffraction images are written directly in the CBF format. The HDF5 format is no longer available.
- Collect status is always visible under the Collect/Pause buttons.
- Detector 2-theta and energy threshold are now written in the CBF image headers.
- The maximum oscillation range (frame width) suggested by automated strategy will not exceed 0.2º

Raster tab
- Both DIALS and DOZOR are offered as spot-finding options.

Image viewing
- Several new image viewing options have been added to improve the visibility of diffracted spots.
- Image viewing options can be selected just above the image, without going into Tools→Options menu.
- adxv zoomed-out viewing is improved (with the padsmooth option). adxv typed at the command line is actually an alias to "adxv -padsmooth".
- The adxv small-spots option improves spot visibility, especially for weak and/or small spots. It can be turned on and off from the Edit→Settings window of adxv.
- David Kissick’s “Small Spots Viewer” improves the spot visibility, especially for weak and/or small spots.
- The DIALS spot viewer is available.

Remote access
- NX players versions 4 and 3 are no longer allowed. When using older sub-versions of players under version 5, users will receive a warning dialog. These players will be allowed but some problems may be encountered.
- VNC option added as a backup, as described in FAQ at https://www.gmca.aps.anl.gov/remote/faq.html
- NX webplayer is currently being tested and will likely be added soon. The option to login with installed NX player will continue to be available.
New features, 2017-1 run

**General**
- On 23ID-D, our vertically focusing mirror has incurred a major problem. As a result, the fluxes for all beam sizes are down 10- to 20-fold. Therefore, you may need to use a combination of decreased attenuation and increased exposure time.
- The mirror problem has also restricted the current energy range on 23ID-D to 6 – 15 keV.

**Data Collection**

For Pilatus3 6M detector, 23ID-D
- In inverse beam data collection, the inverse beam filenames have an added _INV suffix while having the same numbering as set up in the data collection parameters.

**Raster tab, 23ID-D**
- On 23ID-D, DOZOR is used for spot finding. We expect DISTL to be working again soon, followed by DIALS.

**Computing**
- An MX button was added to the MEDM toolbar. It allows the selection of some crystallographic software to be run in a dedicated bash shell. This prevents potential problems between different crystallographic programs when setting environment variables. More detailed instructions can be found at the bottom of the page http://www.gmca.anl.gov/computing/software_crystallography.html
- autoProc by Global Phasing is available for non-commercial users.
- Displaying images in remote sessions with Albula broke after the latest Redhat/CentOS-7 upgrade. Dectris expects to fix Albula within 6 to 9 months. Until then, please use Adxv or embedded JBlulce image viewer. The latest Adxv supports the Eiger HDF5 format.
New features, 2016-3 run

General
- Goniometer support on 23ID-B was modified to allow shorter detector-to-sample distance. Currently, the default minimum is 200mm.
- Extra curtain has been added to the 23ID-D hutch entrance for improved temperature stability.
- Due to an amplifier upgrade, DCM Intensity values are twice as high as the previous values. However, the actual beam intensity is unchanged.

Collect Tab
- In vector mode of data collection on 23ID-B, the discrete option, vector site check and overlaps are now functional.
- On 23ID-B, the inverse beam option has been tested in combination with vector mode.
- Data collection with multiple energies is available.

Analysis tab
- Resolution cutoff for both fast_dp and GMCAproc has been modified to include higher resolution data.
- The plots generated in auto-processing now use $1/\text{resolution}^2$ for the x-axis (instead of resolution in old graphs)

Computing
- SienceDMZ network was made available to our users for the 2015-3 run cycle. We now offer two additional Globus endpoints on the ScienceDMZ network.
  - The old Globus endpoints (on the regular network) are gmca23idd#gridftp and gmca23idb#gridftp
  - The new Globus endpoints (for ScienceDMZ) are gmca23idd#gmca-dmz1 and gmca23idb#gmca-dmz2
  - If Globus endpoint on the user end is on a fast optimized network, increase in data rates up to 4 times can be expected.
New features, 2016-2 run

General
- Eiger 16M detector has been integrated on 23ID-B line. Data files are written in HDF5 format, and are automatically converted to cbf format to allow data processing with XDS, MOFLM and HKL. Converted files are written in cbf subdirectories of the data directories.
- Goniometer support was modified on 23ID-D to allow shorter sample-to-detector distance. Currently, the default minimum is 230mm.

Collect Tab
- On 23ID-B, data collection in Standard and Vector modes are enabled. Discrete option in the Vector mode and inverse beam in combination with vector mode have not been tested.
- On 23ID-B, Shuttered data collection is not offered at this time.

Raster tab
- Raster is fully functional with one exception: the oscillation width must be 0 to ensure shutterless data collection.
New features, 2015-3 run

General
- The new quad collimator is installed, reducing the background by ~60%

Computing
- Operating system has been updated from Centos-6 to Centos-7
- File system has been changed from GFS to BEEGFS
- Graphical desktop has been changed from Gnome-2 to Mate
- Data storage will use one big partition instead of several smaller partitions
- Software for mounting exFAT has been added
- The path to the external hard drive changed from /media/name to /run/media/name
- Globus server was updated to new version.
- Globus via ScienceDMZ is available in testing mode. ScienceDMZ bypasses Argonne firewall and thus may provide up to 6 times faster data transfer speeds compared to regular Globus. Users may need to request setting up ScienceDMZ on their side to achieve these speeds. National universities and government labs are eligible for free help from ESNET with the setup. Please contact your host if you want to try Globus via ScienceDMZ. The IP address of Globus client computer at your institution will need to be provided.

Data backups
- After the OS updates to Centos-7, backing up data to external drives formatted as HFS+ (the default filesystem in MacOSX) became unstable. Until the vendor of HFS+ driver resolves the issue, please refrain from using HFS+ formatted disks for backups. You can still use ext2, ext3, ext4, fat32, exfat, and NTFS formats. The GM/CA Globus server for fast online transfer of data can also be used: [https://www.gmca.aps.anl.gov/remote/globusonline.html](https://www.gmca.aps.anl.gov/remote/globusonline.html)

Sample tab
- The ring light was removed on IDD to allow installation of the new collimator

Screening tab
- 22-character limit is imposed in the CrystalID column of the spreadsheet. If this limit is exceeded, the spreadsheet will not load in JBlulce and will result in a pop-up notification
- If cool-down of the robot gripper exceeds 2 minutes, it indicates a problem and will result in a pop-up notification
- Deviation of the CryoJet flow or the temperature from the set point will result in a pop-up notification when “Start” is clicked

Collect tab
- In Multi Crystal Strategy, when partial data sets are combined, the highest resolution will be passed to the Reference Data tab

Analysis tab
• Auto-processing is faster
• The logs are displayed in qtrview instead of Firefox
• The auto-processing pipeline will use CTRUNCATE instead of TRUNCATE
New features, 2015-2 run

**Hutch tab**
- No changes

**Sample tab**
- No changes

**Screening tab**
- Taking jpeg images of samples is now independent of diffraction images
- “Clear Results” button now offers “by puck” option
- Notification of robot errors, and a guide to fix them, has improved.

**Raster tab**
- No changes

**Scan tab**
- No changes

**Collect tab**
- No changes

**Analysis tab**
- If multiple partial data sets have been processed with GMCAproc, two different versions of combined hkl file will be written in `<prefix>_COMBINED` directory:
  - POINTLESS_AIMLESS directory will contain the combined file in mtz format, produced by POINTLESS
  - XSCALE directory will contain the combined file in XDS_ASCII.HKL file, produced by XSCALE.
  
  Both of the files contain scaled, but not merged data
- Combine Datasets sub-tab moved from Multi-Crystal Strategy to Analysis tab and more information added to the datasets table

**Other**
Big energy moves, whether from Hutch tab or from Scan tab, show a pop-up for a wait period for thermal equilibration.
New features, 2015-1 run

General
- ETA is displayed at the bottom of JBluelce while setting up a collect or raster task
- The 5-digit frame numbering is now in effect
- If the detector is busy or the software is not running, collect and raster will be disabled and further information is available by hovering over the start button
- The 120-sec countdown, if there is a problem with the detector software, is eliminated. The problem is now reported within 5-10 seconds

Sample tab
- No changes

Screening tab
- Crystal scoring and strategy calculations are now implemented for multiple attempts for the same sample

Raster tab
- View/Move modes have been added.
- Instead of right-clicking the video to select “view images”, view mode is automatically switched to during and after each raster
- In view mode, left-clicking a cell will show that cell in the table and load the corresponding diffraction image it in the image viewer of the sample tab
- Diffraction image can also be viewed by selecting a cell from the results table
- User can control the Spotfinder options through the Spotfinder options window. A link in the window shows the documentation for these options
- Spotfinder can be re-run with changed parameters during or after the initial automatic processing
- The search field which was set up in the grid mode, can be offset by typing a number in the offset window
- The spreadsheet icon opens a spreadsheet version of the results table
- The diffraction image icon opens the sample tab peelout in viewer mode
- The keyboard icon opens a quick reference for Raster tab features
- New cell numbering and heat map schemes have been implemented and placed above the raster viewer
- When JBluelce is resized, the raster video will resize with it
- Video can be expanded vertically by moving the slider below it
- Runs can be hidden with the maximize button to add more area
- All SpotFinder output variables can be viewed by choosing the output tab below the video
- Sites can be created by right-clicking a cell in the video
- Sites created from the table, video, or hit selection don’t overwrite each other
- When grid numbers are too close together, numbers are skipped to retain legibility
- Right-clicking a cell on the video provides the option to center that cell
- The site list is automatically hidden when it’s empty, but can be shown by clicking the collapsed vertical header
Typing a number in the table will go to that cell in the table. Hitting “Enter” after that will highlight the corresponding cell in the raster search field.

Columns can be added or removed by right-clicking the header.

Columns can be reorganized by dragging and dropping them.

**Collect tab**

- Graphs of spot total, Bragg candidates and resolution estimate are shown in near-realtime below the image viewer.
- Hovering in the graph shows information for a given frame, and frames can be loaded in the viewer by left clicking or dragging.
- Click the legend items to show or hide the plots.
- Click the downward triangle on the graph to hide it, and the upward triangle at the top of the image viewer to restore.
- In vector mode, batch site selection (or deselection) is implemented. For example, user can select sites from “20 to 30”. Typing only one number (in the first cell) selects or deselects only that site.
- In the vector mode, after entering a number of sites, choosing this option will calculate a step size to fill the defined vector.
- If a collection task is set up with energy moves, a popup will ask to confirm the moves in the current and all subsequent data collection tabs.
- Clicking the reset button above the viewer will center the image and reset the zoom.
- When a collect run is in raster mode, a button “Add current site” will add the current position as a raster site.
- Slowdowns related to working with thousands of frames are reduced.
- The video tutorial and the help document in pdf format have been added in the Multi Crystal Strategy tab.
- XPLAN strategy can be exported into a new collect run.
- The “Merge datasets” has been renamed into “Combine datasets”.
- Version of MOSFLM & BEST displayed in the strategy tab.
- Help sub-tab added in the Strategy tab.
- “Both” option has been added to the background data processing options and it is a default.

**Analysis tab**

- The Help sub-tab has been added.
- “Processed with” drop down menu has been added. Selecting the processing software will display the processing statistics from that software.
- AIMLESS is now used for scaling instead of SCALA.
- Processing with XSCALE is now added for better handling of inverse beam, vector with overlaps, and raster data.

**Other**

- The video tutorial for data transfer with Globus is available on GMCA webpage.
New features, 2014-2 run

General
• Because the IDB and IDD beamlines have different detectors, some of the software tools will differ between the beamlines. They will be pointed out correspondingly.

Sample tab
• Scale bar is added to the high resolution camera view. This bar will be 10 μm, 20 μm or 50 μm, depending on the zoom.

Screening tab
• Some gripper warmup cycles are now avoided, speeding up the overall robot operation.

Raster tab
• Abort button is added to close the shutter immediately and stop the collection, not waiting for the current frame to finish collecting.
• Rastering is now done in horizontal direction.
• The raster exposure time will not be allowed to go below a value such that the required horizontal speed would exceed the motor's limit.
• The cell limit is increased from 1,000 to 10,000 per raster job.
• IDD beamline only: If the oscillation angle is set to 0, rastering will be done shutterless within each row.
• IDD beamline only: SpotFinder processing is done on a separate computer using the Apache SpotFinder server to improve performance.
• ETA estimates now include transition times between the raster cells in shuttered mode (IDB) and the raster rows in the shutterless mode (IDD)

Collect tab
• IDD beamline only: frames within each discrete vector site are collected in shutterless mode.
• ETA estimates now include transition times between the vector sites.
• Abort button is added to close the shutter immediately and stop the collection, not waiting for the current frame to finish collecting.

Analysis tab
• Current data processing subset information displayed in the warning field of Analysis tab.
• A “Settings” sub-tab is added to allow overriding the default XDS parameters.
• Check box is added to allow reprocessing and simultaneous auto-processing with different XDS parameters.
• A button is added on the “Settings” tab to allow the lattice parameters to be imported.
• Data processing results can be browsed in passive mode.

Remote Access
• The NOMACHINE servers have been upgraded from version 3.5 to 4.2. It may cause incompatibility with old NX-3.5 clients. Please use NX-4.2 clients.
New features, 2014-1 run

Both beamlines

Remote access
- NX Client-3 because it is no longer supported by NOMACHINE. Therefore it is being phased out from our remote operations as well. All templates have been updated to NX Player-4. Old templates are still available from legacy page for those who already have Player-3 installed. However, users are urged to upgrade to Player-4.
- OpenNX is no longer supported for the same reason.
- Automatic installation of NX Player-4 through the GMCA web site now requires extra steps of adding GMCA to Java and sometimes web browser security exceptions lists. Please read the GMCA remote FAQ web page for additional details.
- Portable versions of NX Player-4 for MacOS, Linux and Windows, which users can download, unpack and run without administrative privileges, are posted on our web site.

Data processing
- XDS now has a GUI for more convenient data processing. It can be started from a command line by typing xdsGUI.
- As before, HKL2000/3000 site files for both, the MAR and Pilatus detectors, can be found here: http://www.gmca.anl.gov/sitefiles/

IDD

Pilatus3 6M has been installed on the 23ID-D beamline
- It is a Pixel Area Detector with a large, 423.6 x 434.6 mm² sensitive area.
- When compared to CCD detectors used in macromolecular crystallography it has much higher dynamic range (20-bit vs 16-bit).
- Pilatus3 6M can handle 10 times higher count rates than previous generation Pilatus 6M detectors.
- Detector integrated in 23 ID-D beamline has 1mm thick sensor whereas most other Pilatus detectors currently in the field have 0.320 mm. This allows measuring data at higher energies more efficiently.
- Thicker sensor also produces slight parallax (spot elongation) at higher resolutions (higher angles), especially at closer sample-to-detector distances. However, data processing software seems to take it into account during integration.

Image display:
- Images are written in a Crystallographic Binary Format (cbf).
- Although the image files are binary, typical text editors can read their headers.
• ALBULA is image display and analysis software which is provided together with the detector. It has many useful tools for image analysis. Free copy can be downloaded from here: https://www.dectris.com/Albula_Overview.html#main_head_navigation

• ADXV is still an option for users.

• MARccd GUI can also be used to display images. It can be started on the MAR computer by clicking on the detector icon, or on any computer by command line command marview. Beware that if you are using MARccd GUI, the beam center is reported correctly in pixels but not in millimeters. As a consequence, the resolution is not reported correctly.

• Both ALBULA and ADXV report the origin in pixels and therefore resolution shown in these programs is correct.

Data collection:
Much work still remains to establish optimal protocols for data collection with Pilatus. However, some preliminary recommendations can be offered already:

• Due to higher dynamic range (20-bit vs 16-bit), Pilatus3 6M will “allow” users to kill the sample quicker. I.e., if the spot saturation is used as criterion for exposure levels (as was often done with the CCD detectors), the sample will be overexposed.

• Dose per diffracting volume of the sample can be spread over many frames collected with much shorter exposure times (θ-slicing). For example, 0.1° frames with 0.1 sec exposure. Using 0.2° and 0.2 sec is a good alternative reducing the number of frames twice and increasing the counts on the detector.

• If number of frames is not a concern, so called “dose slicing” is also recommended in literature. For example, instead of collecting 90 degrees of data with 0.1° slices (900 frames), 0.1 sec exposure time and beam intensity I, one collects same 90 degrees of data four times with intensity of I/4 (4-fold attenuation) for total of 3600 images. This approach can be used to collect multiple full sets (multiple 90° swaths in the example used here) with lower dose.

• If the dose slicing is used, it is recommended to move the detector slightly between each data set. This will minimize the systematic errors and will also increase the completeness as the reflections lost to the gaps in some sets will be recorded in others.

• Data are being collected in shutterless mode. It significantly decreases the time needed to collect large number of frames. It also reduces the error introduced by shutter operation. Note that in the present implementation, the shutterless mode works only for “standard” data collection mode. It is not implemented for “vector” mode or for rastering.

• In rastering, if the crystal does not diffract strongly, using 0.1° frames and 0.1 sec exposures may not be advisable as it will produce very few spots. Using wider frame widths (0.3 -0.5 degrees) even with the same 0.1 sec exposures will increase the counts in each recorder Bragg spot making the rastering results more reliable.

• For useful discussions on data collection, please read
  - Optimal Fine phi-slicing for Single-Photon-Counting Pixel Detectors
Data processing:

- GMCA staff has tried to process some test data sets with XDS, MOSFLM and HKL2000 and they all seemed to work as usual, without any additional steps.
- Just a reminder that automated data processing, using XDS, is implemented in JBlulce
- You will need the most recent version of HKL2000 (v704y) and you may have to contact the vendor for a license in order to read the PILATUS images.
New features in data collection and beamline controls
As of October 1, 2013

General
- Few changes have been made in preparation for integration of Pilatus detector. They are transparent to users.
- Focusing mirrors on IDB have moved closer to the sample, increasing the flux.
- Beam X/Y are correctly calculated in runadxv for binned images. Image size and pixel size are taken from the image header, instead of being hard-coded.

Remote access
- In addition to NxClient-3 used before, now users can also automatically install brand new NxPlayer-4. As with NxClient-3, the installation should not require administrative access to the computer, but needs Oracle Java operational in web browser.
- A patched version of OpenNX is available for MacOS Lion users at the GM/CA web site. This should resolve the keyboard mapping problem experienced by some MacOS users.
- bdxv is now available for viewing diffraction images. At the moment it runs from a command line and works properly via remote NX connections, resolving “blank images” problem seen some times with adxv.

MX software
- Please note that coot and xia2 within ccp4i are still those supplied with CCP4. For the latest versions, run the programs from command line.

JBluIce Hutch tab:
- No changes

JBluIce Sample tab:
- Diffraction image viewer has improved. Images can be dragged (left or middle buttons), or zoomed in (right button). The toolbar has been streamlined and moved to the top. “Pan” arrow buttons have been removed.

JBluIce Screening tab/Sample automounter
- Screening can be paused with Start/Pause button. Once pause is clicked, current image collection will finish and then screening will pause. Clicking Start after that will resume screening from the position of the green arrow.
- When Raster option is selected for centering, it automatically centers on the first site found. BEWARE: in current implementation, other sites on the same mount will not be centered and scored.

JBluIce Raster tab:
• Processing checkbox has been removed. If processing must be disabled, users should contact their host.

JBlulce Collect and Analysis tabs:
• See the image viewer comments under “Sample tab” above.
• Strategy will now remember the software (MOSFLM or BEST) used for processing particular space group.
• In multi-crystal strategy, .sca files can now be used as reference data.
• New “Reprocessing” sub-tab has been added in the analysis tab. Here data can be reprocessed with user-defined space group and cell parameters.
• Each partial data set, processed on the fly, will be represented with its own curve on the plots. Double-clicking a curve will launch CCP4 loggraph.
• “Image Set” now displays both sets of inverse beam data which are being processed currently.

JBlulce Scan tab:
  o No changes
New features in data collection and beamline controls
As of June 1, 2013

General
- To streamline data backup, the default directory within JBlulce has changed from user home directory to a pre-set one. For example, the data collection date: /mnt/share1/username/23IDD_2013_07_31
- Directory fields now have two parts: default on the left (../) and user-defined in the middle and browse on the right.
- Hovering over “../” with mouse will show the explicit path and clicking on it will open that directory.
- All parameters of screening, raster, scanning, data collection and analysis will be stored in MySQL database.

Hutch tab:

Sample tab:

Screening tab/Sample automounter
- Non-editable current directory indicator is added under the directory selection field of the “Screening” tab.
- Stop button is added after auto-centering.

Raster tab:
- Diffraction images, corresponding to the selected raster cells can be displayed.
- Default high resolution limit for the spot search during rastering is now updated whenever relevant motor positions are changed. This resolution corresponds to the detector edge but can be manually overridden.
- The “Fix” button is added to prevent resolution updates.
- A PNG snapshot is saved automatically after completion of each raster job.
- A PNG snapshot can be saved manually as well from the right-click menu. If the dialogue is cancelled, the snapshot will be still saved with a defaults name – same as in previous bullet item.

Collect and Analysis tabs:
- A beta version of multi-crystal data collection is added. Best data collection angles for the current crystal will be calculated based on the available partial data. Currently this tool can utilize only XDS.
- Intermediate processing results (first 5 frame, first 10 frames etc) are saved in separate directories. “Image Set:” selection in the “Analysis” tab allows the data statistics table and the plots to be updated for specific data set.
- In-house wrapper for automated data processing is being developed and can be selected as GMCAProc from the Tools/Options menu.
• If GMCAProc is selected while processing “inverse beam” data, or data from multiple sites of the same crystal, the crystal orientation matrix for the first set is used as a reference for all subsequent sets.
• If another client becomes master by force, collection will be paused. To resume data collection, “become master by force” and then click “Collect”.
• JBlulce instance, currently collecting data, is not allowed to close, or to become “passive”
• If JBlulce crashed while collecting data, upon restart it will automatically become master and will pause data collection.

Scan tab:
• Previous scan files (BIP) can be loaded back in to JBlulce from the File pull-down menu.
• After completion of the edge scan, the $f'$ and $f''$ values, along with energies, are printed on the image.

As of February 3, 2013

General

Hutch tab

Sample tab:

Screening tab/Sample automounter
• Multiple (up to 20) consecutive images can be collected at each of the three possible angles.
• Every time strategy results are recalculated in the Collect tab, the sample Spreadsheet in the screening tab is updated with new results.
• Gripper is automatically sent to warm up when the expected data collection time exceeds the scheduled warm up time.

Raster tab:
• Multiple rastering sites, found in interactive mode, can be manually selected and passed to the Collect tab for further data collection.
• Raster parameters are now also saved.

Collect and Analysis tabs:
• Automated data processing starts after specified (by staff) sweep of data is collected. At the completion of processing, new images are detected and processing starts again from the beginning. Processing results, which are also displayed in the Analysis tab, are overwritten each time processing is completed.
• AIMLESS replaced SCALA as a default program for scaling and merging. SCALA can be selected from Options menu.
Every time strategy results are recalculated in the Collect tab, the sample spreadsheet in the Screening tab is updated with new results.
Helical mode selection added, making the setup more straightforward.

Scan tab:

•
As of October 5, 2012

General
- A control panel is implemented under Tools → Options
- The CCD binning mode can be changed for screening (in control panel), rastering (in raster tab) and data collection (in control panel) between 72 μm and 144 μm size pixels
- File and directory selection dialogs are improved

Hutch tab
- Beam alignment graphs are integrated in the hutch tab

Sample tab:
- Measured full beamsize is shown on Highres tab beam display options as Full Width at Half-Max. It is also saved in the experimental log file.
- When main Sample tab or peel-out Sample tab window is resized, the video and diffraction image will resize accordingly.

Screening tab
- Diffraction-based centering is an option during screening
- Beam size selection added to screening tab data collection parameters.
- Time remaining till next warm-up is displayed below the warm-up button on screening tab.
- New button added for popup window to show the sample status

Raster tab:
- Diffraction rastering can be done with still images

Collect tab:
- fast_dp was added as a default for data processing.
- Data processing works for multiple sites from vector/raster data collection, vector collection with overlaps and inverse beam. Combined mtz file available in the processing directory.
- Strategy and Data processing results are automatically saved to excel file.

Scan tab:
- Chooch results for edge scans are shown immediately after the scan finishes.
As of June 4, 2012

General
- PSS panel and the search boxes have changed
- Cancel option was added to the JBlulce startup screen
- The file name and directory dialogs have changed
- The ring light will turn on when images are being collected and will turn off when collection is completed
- The “+” and “-” buttons on the diffraction image viewer will display the “next” and “previous” images even if their numbers are not adjacent
- From the Options pull-down menu, BEST or MOSFLM can be selected for strategy

Hutch tab
- Beam optimization scans are displayed in the hutch tab as well
- Pull-down arrows replaced the “A” buttons for stopping the motors. They will be replaced later with stop signs

Screening tab
- Has moved in front of the Collect tab

Sample tab
- Point-and-click works only with left click
- Point and click move undo/redo menu option is added

Raster tab:
- Resolution limit selection is added to both Interactive and Auto rater tabs
- In Auto mode, the search polygons can be set up automatically, or semi-automatically to match the mounted loop
- When the sample is unmounted, all raster-related information is deleted. This can be turned on or off from the menu option
- Once rastering job starts, the “Start” button changes into “Resume”
- Display option check boxes have been replaced by toggle buttons
- Site centering buttons have been replaced by an option in the right click menu
- Results from interactive raster runs can be added to the site list with right click
- The site naming convention has changed. For example, AF3O2 would mean that the site came from Auto mode, fine-step raster job number 3, 2nd hit from the run in orthogonal plane. Right click on the site explains the site name
- Collect runs can be created for specific raster sites from right-click menu
- Multiple raster sites can be passed to the Collect tab by CTRL + right click
- “A” is added to file name prefix in the Auto mode
- Reliability of the Auto raster has been improved
- Color map can be hidden in fluorescence raster
- Fluorescence raster log is now written, similar to diffraction raster
• Right click on the raster video allows the image to be saved, including the color maps and any other overlays

Collect tab:
• Raster sites can be added to the 0 tab
• Beamstop distance has been removed from the Collect tab
• Beam size is added to the Collect tab. The values are constrained to actual achievable size (5μm minimum and ± 3σ maximum)
• When the sample is unmounted, all raster- and vector-related information is deleted. This feature can be turned on or off from the menu option
• Raster or vector sites can be double-clicked to center
• “Select all” and “Select none” buttons have been added to the vector site setup
• The “Export strategy” button is added
• Run sequence filename column resizes to display the whole file name
• Diffraction images have finer contrast control at lower values
• A frame collection may be delayed by 5 sec if the Keithley gain had to be changed

Scan:
• Fluorescence spectrum plot shows vertical bars based on the selected elements
• Colors are slightly varied for multiple edges of the same element
• “Show all” button will display the edges of all elemental listed under the plot
• For overlapping edges, the nearby edge can be identified by hovering over with the mouse
• Zooming in can be done by left click and drag
• Right click offers menu of options, including zoom out, print etc
• Choosch selection can be changed by dragging the corresponding bars and restored by clicking the “Defaults” button

Analysis tab:
This is a new tab. When auto-processing is selected in the Collect tab, data will be processed with XDS, POINTLESS, SCALA and TRUNCATE. Results will be displayed in this tab. Full log files can be displayed by clicking appropriate buttons
As of Feb 6, 2012

Raster tab:
- In auto mode, the list of found and centered sites is passed to collect tab

Collect tab:
- Collect User Interface has been redesigned substantially
- Collect tab diffraction viewer resizes to fill available space
- Run sequence table can be expanded (and restored to original size) by clicking the double arrows
- The Distance column in the run sequence table is replaced by Site Number
- Strategy
  - All possible space groups in the Labelit solution are displayed in strategy window
  - By default only the space groups within highest point group are processed initially
  - Multiple space groups are processed in parallel to increase the speed
  - User can choose lower symmetry solution, JBluice will process and display strategy
- Vector and Raster modes
  - Raster mode is added
  - Inverse beam geometry and multiple wavelength data collection now work with Vector and Raster modes
  - In Vector or Raster modes of data collection, given swath of data with inverse beam geometry or with multiple wavelengths is always measured from same sites
- XDS
  - XDS checkbox is changed to a dropdown with three choices: None, Native, Anomalous
  - When a failure “INSUFFICIENT PERCENTAGE of spots” is encountered, XDS runs second time to complete the integration of data.
  - XDS can process Anomalous data

Scan:
- Chooch plot display is integrated into JBlulce. PDF is still available by double-clicking the plot.
- Edge scan adaptive mode option is added to the menu

Other:
- There is a new GUI for starting the MAR software remotely
- In the “Help” pull-down menu, Selecting “Crystallographic Software” opens the web browser and displays clickable list of available software
- In the “Help” pull-down menu, Selecting “Video Tutorials” opens the web browser and displays clickable list of available tutorials
- Operating system has been upgraded to CentOS 6.2
• When external hard disk is mounted, the device name is assigned differently, not as /media/removable*#

As of October 10, 2011

Sample tab:
• Beamsise selection moved to the top.
• Pull-down menu for size display has disappeared. Selection can be made in High Res. View.

Raster tab:
• New parameter – “Corrected Bragg” is introduced to subtract erroneous “Bragg” spots
• Results in auto-raster are more reliable with corrected Bragg spots
• Macros are implemented for raster parameters
• Diffraction raster speed has improved
• Camera zoom can be changed during raster
• “Loop Z” default has changed to 200.
• In the raster heat map, the maximum value is always red.

Collect tab:
• A copy button copies the vector as well as the collect parameters to a new tab
• Diffraction image updates can be stopped with the 'Stop’ check box. The +/-buttons can be used to browse through images.
• Once a vector is set up, clicking "site check" and then "collect" will take the first frame for each site.
• Vector sites can be manually centered using the site list.
• The user is prompted to delete the vector when changing out of vector mode.
• There is a selection button (XDSProc) for automated processing with XDS.
• Strategy has a few changes:
  o Highest symmetry or P1 are selectable and strategy output is displayed according to this selection.
  o Strategy can be reported for native or anomalous data. For the latter, the results can be displayed for continuous or inverse beam modes.
  o Parameters that can be exported are in green.
  o All results can be saved in an Excel spreadsheet
  o All strategy results are now kept and can be reviewed as needed

Other:
• adxv follow mode does not freeze after a few hundred frames.
As of June 4, 2011

Raster tab:
- Auto-raster
  - User enters rastering parameters and initial search area
  - JBlulce runs multiple grid searches to find promising sites in two orthogonal planes
  - Sites are individually centered for data collection and crystal size reported
- “Position Sync” is now replaced by “Save Position”
  - Before a raster run starts, the sample position can be saved
  - Once a rastering run starts, user saved positions are cleared

Collect tab:
- Collect tab layout is slightly changed
  - “Single” mode disables vector collection for a given run
  - “Vector” mode enables setting the vector position and then the parameters
  - “Vector” options are moved to a separate sub-tab
- Collect tab field interaction is improved
  - When setting up vector collection, only the "step size" and "number of sites" fields will significantly change the number and spacing of the sites.
  - It's recommended that "step size" and "number of sites" are set first, before any other parameters.
- Strategy
  - In run 0, the user checks "strategy" and enters a second frame angle
  - Clicking "collect" takes two frames and processes them to generate a data collection strategy
  - The results are viewed on the strategy tab
  - Clicking "export" will create a new run tab with the generated strategy
- The collect run 0 start angle field has a dropdown for +-90 degrees

Screening tab:
- Separate pop-up window with the name and status of the mounted sample

Log tab:
- Beam X,Y and Vector parameters are saved in the log file.
- Log files are now written for images collected from the Screening tab

Other:
- Red Hat EL6 support
  - XDS input file is written for a data set containing more than 5 images.
    User can type xds or xds_par in the sub folder for processing. For now, unit cell parameters should be changed manually.
As of 02/06/11

Sample tab:
- High res camera tab has color-coded display of multiple beam sizes
- The size of the displayed full beam can be manipulated by hosts
- Guard Slit size display added to the sample tab

Raster tab:
- Polygon selection in raster tab, including multiple polygons
- Old-style centered rectangle selection
- Display of the beam size which will be used for rastering
- Manual override of automatically selected cell and beam sizes
- If the sample was mounted by the robot, default file, related to the current sample, is put in raster tab
- Color-coded display of the results
- Fluorescence rastering can be done in shuttle mode
- Raster results now list absolute motor positions

Collect tab:
- Selection of the number of sites for data collection
- Sites are now numbered in the vector collection

Screening tab:
- Rinse/Wash buttons added
- Prefix override
- Crystal ID-based default file name is put in the raster tab

Log tab:
- I0 and active beamstop intensity values are plotted as function of the frame number

Other:
- If autocentering fails, it gives a pop-up warning
- adxv can update images during data collection
As of 10/10/10

General:
- Blu-Ice is now JbluIce
- Error messages are improved when requesting invalid parameters

Hutch tab:
- Resolution predictor takes into account 2θ and displays all resolution circles

Sample tab:
- Wash and rinse added in “Sample Tools”.
- Annealing by CryoJet flow control and by moving the sample are together
- Motions are disabled during diffraction image measurement

Raster tab:
- Rastering cell sizes are determined semi-automatically when the grid size is entered
- Beam size is set automatically depending on the cell size
- “Position sync” is added
- Results are being written in a separate spreadsheet
- Fluorescence rastering results are displayed same way as diffraction rastering

Collect tab:
- Resolution predictor displays resolution rings correctly when 2θ is not 0
- Vector data collection feature is user-selectable

Screening tab:
- Spreadsheets with xlsx format are accepted
- “Update” button is added
- “Autoindex-Strategy” button added
- Right click on the spreadsheet window brings up pull-down menu
- Data collection parameters are independent from the Collect tab
- Mouse-over displays brief explanations
- Motions are disabled during diffraction image measurement

Scan tab:
- Center of the plot can be defined manually

Robot dewar:
- Improved dewars